CDOT Working with Model Files and Sheet Files

VA R

e e, T
DEPARTMENT OF TRANSPORTATION

This document defines how to use and manage model and sheet files in a typical CDOT
workflow. The document begins describing the data that each type of file should contain along
with typical examples to illustrate the differences. The locations for storing these files are
identified. The steps to create a new model and sheet files and how to change the file settings to
work with different plotting scales are explained. Finally, the process for referencing model files
for review or printing is covered.

File Types
Model Files

Model files usually contain design graphics that are placed at the correct real world coordinates
or detail graphics that are not dependant on real world coordinates. Model files are files that are
ready to be used as a reference file by other model files for further design or to be referenced by
sheet files for the purpose of plotting. Typical data included in a model file that is drawn at the
correct real world coordinates would include planemetrics for alignments, contours, utility lines,
building outlines, structures, and any other DTM features. Model file data that is not dependent
on real world coordinates would include typical sections, profiles, detail drawings, and tabulation
sheets.

A model file will usually contain only one type of data. For example, one model file
would contain only existing topography data, while another would contain only geometry
data. Separate model files should be used for cross-sections and profiles. Dividing the
data types into separate model files will allow for the most flexibility in how the data is
utilized both by the specialty group team members and the secondary users that need to
reference the data. This method of managing model files also minimizes level
management by not having unrelated data in the file.
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Another characteristic of the design file is that the graphics in the file usually represent
the entire project. These graphics will later be referenced into a sheet file and clipped to
fit the boundaries of the sheet.

A distinct type of model file is the working file.
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Working Files

Working files are model files that are being developed and/or revised and are not ready
for use by other specialty groups or team members. These files usually have the owners’
initials included in the filename as a way to distinguish the file from the ready-to-use
model file. The differences between a model file and a working file is the completeness
of the file and its availability to others.

Sheet Files

Sheet files are MicroStation DGN files that contain the data required for printing. They
are created by referencing in various model files that either represent directly or add
clarification to the features that will be constructed from the printed sheet and a border
file. In addition to containing reference files, typical data that would be included in a
sheet would be informational text, such as callouts and dimensions, a directional arrow if
appropriate, and other non-engineering information such as logos or stamps.
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The graphics in a sheet file represent only a portion of the entire design and are usually
included within a standard border. The image above is a portion of the graphic
representing the design file on the previous page.

File Management

Each of these files is owned by the Project Manager of the specialty group whose data is
contained in the file and updated by the assigned team member. A team member from
one specialty group should not update the file(s) of a team member from another
specialty group.
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File Naming Conventions

The CDOT naming standard uses a formula that restricts the character placement, ensures
unique file names, and identifies the information contained in the file.

All CDOT projects must follow these file naming conventions. Standardizing file names
is necessary for effective management of the large numbers of files needed to produce a
set of design plans.

CDOT files are named in a standard format that identifies the file’s project, the data
contained within it, and the product used for its creation. The naming convention is
illustrated as follows:

) Specialty Annotation Scale
Joh F‘I'Oject cﬂde Group {optional}

JPCHEXXX XXXXEHHXXXYYY

2

Standardized Name Descripton
(optional)

Job Project Code (JPC) is the CDOT project code, formerly known as the project
subaccount number.

Specialty Group is the standardized abbreviation for the specialty group that the owner
of the file is with.

Standardized Name denotes the type of data that is contained in the file.

Annotation Scale including the annotation scale in the file name is optional. However, it
should be included in file names for projects that use multiple annotation scales.

Description A brief description can be used to further identify a model file. For sheet
files, this field is used as a counter to differentiate between multiple files of a specific

type.

File Extensions define the product used for its creation. Examples would be dgn for
MicroStation, DTM for an InRoads surface, etc.

An example file name for a MicroStation design file would look like the following.
12345DES_Model100US285.dgn

12345 indicating the CDOT Project Number, DES indicates it is Roadway Design’s
model file and 100 indicating it uses a 1’=100" annotation scale, US285 is a description
identifying the highway this model depicts. . DGN is the default extension for
MicroStation design files.

Note: A seventh segment is used on Working Files. This segment should be the initials of the
designer or engineer who is working on the file.
Example: CU12345DES_Model100.dgn where CU, are the initials of the designer or
engineer (in this example, CU stands for “CDOT User”).
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Storing Model Files and Sheet Files

Model File Location

Model files should be stored in the JPC#\SpecialtyGroup\Drawings\Reference_Files
folder. The exception to this is for cross-sections (design or construction) which have
their own sub-directory under \Drawings sub-directory. Cross sections are separated
from the rest of the model files at the request of the Reproduction department to simplify
the process of assembling plan sets.

Working File Location

Working files should be stored in the \JPC#\Specialty Group\Working folder.
Sheet File Location

Sheet files should be stored in the \JPC#\Specialty Group\Drawings folder.
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Creating a Model and Sheet Files

During the setup of a project, several model and sheet files are auto-populated into the
\JPC#\SpecialtyGroup\Drawings\Reference_Files and \JPC#\Specialty
Group\Drawings directories of each of the specialty group folders and have the CDOT
standard file names already assigned. (Construction and Planning are exceptions and do
not have any auto-populated files.) These auto-populated files can be modified to
included project specific information before being used to create new drawings. In
addition to the auto-populated files, standard 2D and 3D seed files are available from the
C:\Program Files\Workspace-CDOT\Standards-Global\MicroStation\Seed
directory. These files are global standards and are write protected so that no changes can
be made.
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Several of methods can be used to begin a new drawing; 1) Use the Windows Explorer to
copy, paste, and rename a file, or 2) use the MicroStation Manager window to create a
new file using a seed file or to open a drawing and then use the “save-as” command to
create the new file. If a new file with project specific data is required, use the Windows
Explorer method. Otherwise, the MicroStation Manager method should be used.

Using Windows Explorer

1. Open the Windows Explorer window and navigate to the desired
\Projects\JPC#\Specialty Group\ folder. Right Click on the desired file and
select Copy from the menu.

¥ Reference_Files E]@
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2 B Design F5icony of 12345065 _tadel,, J=——Rename this file

) Calculations
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= |) Drawings
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) InRoads Explare
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22 Reports Search. ..
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=[5 Hydraulics Sharing and Security. ..
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Paste
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2. Inthe blank area below the file list, right click and select Paste from the menu.

3. A copy of the selected file is placed in the folder. Rename the new file according to
the file naming conventions. To rename the file right click on the file name and select
Rename from the menu. Type in the new name and press the Enter key to finish.
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Using a Seed File

1.

Open MicroStation from the Start menu (or desktop icon if available). From the
MicroStation Manager select File > New. If MicroStation is already open, select File
> New from the menu. Both operations will display the MicroStation Manager
window.

MicroStation Manager
Eile | Directory  Help
I Mew... Chrl+M ies:
Copy... ign‘Drawings'R eference_Filesh 3D -va DG
Bename. ..
Delete... Djectz
Properties Alt+Enter 288.8
esign
Merge... Drawings
Comprass > Fieference_Files
Upgrade Files to %8...
List Files of Type: Diriwes:
MicroStation DGM Files [* dan] '| =2 = —
[ Bead-Only Cancel
[~ Show File [cons
Workspace -
= User: [CDOT User -]
P Project: [12345 =]
o= Interface: [COOT 3|

From the New window, click on the Select button to display the Select Seed File
window.

From the Select Seed File window, highlight the desired seed file. There are three
seed files available: 2D-Seed CDOT.dgn, 3D-Seed_CDOT.dgn, and 4-Sig-Fig-
Seed_CDOT>dgn. The 3D-Seed_CDOT.dgn can be used for any model or sheet file,
but must be used for data that is located at real world coordinates. The 2D-

Seed CDOT.dgn can be used for sheet files and for model files whose data does not
need to be at real world coordinates. 4-Sig-Fig-Seed CDOT.dgn is a bridge specific
seed file.

Click the OK button to accept the selection. This will dismiss the Select Seed File
window.

In the New window, type the desired file name (Refer to the naming conventions
above). Click the OK button to accept the file name. MicroStation will open with the
newly created file.
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Annotation and Line Style Scale

While the elements themselves are usually drawn at a 1’ = 1’ scale, a scale factor is set
for line styles and text so that its size will be appropriate when printed.

Setting the Annotation Scale

Annotation Scale controls text and dimension size. It is set in the model properties dialog

box.

1. Select the Models icon from the Primary Tools toolbar.

Primary Tools

X
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2. This displays the Models dialog box. From here, select the Edit Model Properties

icon.
F Models =) O
=3
Type | 2D/3D| Name
m] #  CDOT Default

| |

2l

3. Inthe Model Properties dialog box, select the desired Annotation Scale.
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4. <D>the OK icon to accept the selection. This will close the Model Properties
dialog box. The Models dialog box can also be closed.

Setting the Line Style Scale

1. Select Element > Line Style > Custom from the MicroStation Menu bar.
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2. This displays the Line Styles dialog box. Key in the desired line style scale in the
Scale Factor field.

P Line Styles g o

Mames i~ wiidth

BRDG_FRebar I Ongin [0000
DES_CURBGUTTEF T End: [omm
DES_CURBGUTTEF

DES_CURBGUTTEF ¥ Scale factor: 1 0000000
DES_CURBGUTTEF

DES_GUTTER_evisl v Shit Mone ¥

_AMicroStationt SymbologyCOOT_Linestyles. rzc

Click to Activate [Patten 53]

3. Close the Line Styles dialog box.

Note: Changing the line style scale factor will not automatically update those elements
that were in the file before the scale was changed.

4. Set the Active Level to that of the element to be changed.

5. Select the Change Element Attributes command. Turn on Use Active Attributes and
Style. Data on the element to be updated then Data to accept.

= Change Element Attr... E]

Method:  Chanage i
I|7 Uze éctive Attributes I
ilevel: | =l

[ Colar:
!V Style: FEMCE_BarbedWir_x
Weight:

[T Class
r dnside  ~|
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Annotation Scales and Line Style Scales are set up so that when the files are attached to a
sheet file the text and line symbology will be the proper size. This holds true even if
references of multiple scales are used. For more information see:

CDOT Sheet File Creation Multiple Scales
Using Model Files From Other Users As References

A reference is a model that is attached to and displayed within the active model or sheet
file for design or printing purposes. Elements in a reference display as though they were
in the active model. Although you cannot manipulate the elements in a reference, you can
snap to them and even copy them into the active model.

Model files created by other users can be used as references even if the file resides on a
different computer. This is done by mapping the remote computer (the one containing
the file to be referenced) to a drive letter on the local computer.

Mapping a Remote Computer

1. Open the My Computer window from the Start menu or desktop icon (if available).

|
1
b Adobe Acrobat & _‘)g Elx:Lomputen
5

~ Professional =—
“j‘ My Metwork Places

@ Microsoft Office Word 2003
G—‘ Control Panel

Set Program Access and
Defaults
e, Conneck To 3 _'J

L

g Printers and Faxes

My Computer

@) Help and Suppart

I_) Search
All Programs D 7~ Run...

__'] Undack Computer J Log OFf h i)l Shut Down

2. From the My Computer window, select Tools > Map Network Drive.

4 My Computer

File Edit Wiew Favorites I Toaols | Help

? Map Metwark Drive, .,
Disconneck Metwark Drive, ..

; Synchronize. ..
Address | B My Computer

Folder Opkions. ..

In the Map Network Drive dialog box, select the desired Drive letter.

4. In the Folder field, enter the desired computer name and directory. The Browse icon
can also be used to locate and select this information. The following format is used
when keying in the computer information:

\\computer_name\Projects\JPC#\
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5. If the information on the remote computer will be required over a period of many

days, check on the Reconnect at Login option.

6. <D> the Finish icon to complete the process.

Map Network Drive

=]

Windows can help you connect ko a shared netwark Folder
and assign a drive letker to the connection so that vou can
access the folder using My Computer,

Specify the drive letter For the connection and the Faolder
that wou want to conneck ko

Drive:

Folder:

Ny W |

NcamputerProject s WJPCE V_[ Browse, .. l

Exarple: Viserverishare
Reconnect at lagon |

Connect using a differ

Orage ar Con toa

Finish [ Zancel ]

Files from the remote computer can now be referenced into local drawings. The
procedures for referencing files are covered in the following workflows:

CDOT Sheet File Creation
CDOT Sheet File Creation Multiple Scales

Nested Attachments

Reference attachment nesting determines what happens when a file containing
attachments is attached to the active dgn file. The following examples are used to
illustrate the different nesting options.

Four files are used in the examples. Blank.dgn is the active file. Square.dgn,
Triangle.dgn, and Circle.dgn will be used as attachments. For the purposes of the

examples, Circle.dgn has been previously attached to Square.dgn and Triangle.dgn has

been previously attached to Circle.dgn.
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No Nesting
With this option, only the selected file will visible in the active file.

Eﬂeferences (1 of 1 unique, 1 displayed) g
Tools  Settings

B BB & 0 ohe® 2] 2080 5 5 7 53 () 3 HiteMode: Boundaries ~

Slat | File Name Madsl Description Logical Presertation | 3] ad | & ]
1 Square.dgn CDOT Default  Global Origin aligne. Wiehame v+ o

Scale [1.000000 1000000 Raetstion [oo0r v [ooor z [ooo
[ Ty Tzl o ¢o B t[q o Mesting b [T designdrawings weference filestsquare dan

Live Nesting
This option allows files that are attached to the selected file to be viewed.

5 References (2 of 2 unique, 2 displayed) g
Tools  Settings

Bev| BB & ¢ Gy (5] 50 88 ) By ofn 2 ) R WiteMode: Boundaies ¥

51t | File Name Model Description Logical Presentation | (51| <4 | K ]
1 Squaedgn COOT Defaul Global Diign aligne.. Widame S o
Scale [T000000 : [T.000000  Retation [G°00" v [00" z [To0"

[l T Jazlzm = <= 5l 1@ Live Mesting ¥ | Depth: [T . \designdiawings'eference_filestsquare.dan

The number of levels of attachments that can be viewed in this manner is controlled by
the Depth setting. In the above illustration, Circle.dgn is attached directly to Square.dgn
and is visible with a Depth setting of ‘1’. By changing the Depth setting to ‘2’, files
attached to Circle.dgn (in this case Triangle.dgn) become visible.
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3 References (3 of 3 unique, 3 displayed) E]
Tools  Settings
Bev| R E & ) 3B 2] A0 EB 50 P 7 B9 () W HikeMode: Boundaries ¥ |
Slot | File Name Model Descriplion Logical Presentation | 5] a4 | & ‘
1 Square.dgn CDOT Default Global Origin aligne. \Wireframe A A
Scale [1.000000 : [1.000000  Rotation [0°000" v [orog” Z [oroor
EE’T’EE ay gaﬁ 'tgzﬁ Live Nesting ¥ | Depth: |2_ ... wdesignidrawingshieferencefileshsquare.dgn

With live nesting, any reference file settings changes affect all of the visible files. So, for
example, if the Display is turned off for Square.dgn, Circle.dgn and Triangle.dgn are
turned off also. (Note: level display of nested attachments is discussed below.)

Copy Attachments

This option also allows multiple levels of attachments to be viewed, however, it also
allows independent control of each attachment. Compare the illustration below with
those for Live Nesting. Here, each attached file is listed in the References dialog box and

its settings can be adjusted independently.

ERefelentzes (3 of 3 unique, 3 displayed)

ok

Toals  Settings

- B3 &

&= (2] A0 50 50 7

“j =g @ % Hiite Mode:  Boundaries ¥

Slot | File Name: Model Description Logical Presentation | [5]) adf | K |
1 Sguare.dan CDOT Default Global Onigin aligne... wireliame N
2 Circle.don COOT Default Global Onigin aligne...  Ref wirelrame A A
3 Triangle.dan COOT Default Global Origin aligne... Ref1 Wiretrame IR

Scale [1.000000 : [1.000000  Ratation [0°00" v [oroo” z [oog”

E’EKEE ay ga’ﬁ 'I:?:W Copy Attachments ¥ | Depth: ’2_ ..designidrawingsreference_fileshsquare.dgn

Changing the Nesting Mode

The Nesting Mode for a single file or a group of attachments can be changed from the
References dialog box. To change the nesting mode:

1. Highlight the desired files from the list.
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2. Use the pull-down at the bottom of the dialog box to select the desired nesting mode.

F=References (3 of 3 unique, 3 displayed) E]
Tools  Settings
= - i A B SBEY B, o D Hilitz Mode:  Boundaries ™
= 2 e ¢ B= B+ =]
Slot | File Hame b odel Description Logical Presentation | 5] 9 | & |
1 Square.dgn COOT Default Global Drigin aligne. . Wireframe W W
2 Circle.dgn COOT Default Global Origin aligne... Ref YWireframe [P N
3 Tnangle.dgn COOT Default Global Drigin aligne...  Ref-1 WWireframe A A
Scale [1.000000 : [1.000000  Rotation [0°0D" v oo el N
E’JFEE (=) galﬁ b= I » Mo Mesting [epth: |1_ .Sudrawingshreference_fileshtiangle. dgn
Live MNesting

LCopy Attachments

Attachment Level Display

It is probable that elements in attachments will occupy levels that have the same name as
levels in the active file or other attachments. This is possible because the level display
operates independently on the active file and each attachment regardless of the nesting

mode.
Turning Levels On and Off in Attachments
1. Select the Level Display icon from the MicroStation Primary Tools tool bar.

R - @

Primary Tools

El -5 -E-3-

©

2. Select the file whose levels will be turned on or off. The file display within the Level
Display dialog box will be different depending on the nesting mode.

Level Display 1] |Level Display =
| | | | | | | Wiew Dizplay hd | | | | | | | Yiew Display b
=+hd] Blank dgn =+h Blank dan
@ Square.dgn = @ Square.dgn
Ref, Circle.dgn = Circle.dan
@ Ref-1, Triangle.dan @ Triangle.dgn

DRAFT_CO-Red
UTIL )
UTIL

UTIL_TELE
UTIL_TELE

On the left the files were attached separately or with the Copy Attachment nesting
mode. On the right, the files were attached using live nesting.
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3. Click on the desired level to change its view status. When using live nesting, if the
file tree is not expanded level display changes to a particular file will affect the files
collapsed underneath it.

Continuing the examples above, the attachments were made using Live Nesting with a
Depth of ‘2°. All of the elements shown were drawn on the DRAFT_CO-Red level (the
line is in the active file, Blank.dgn). In the illustration below, the DRAFT_CO-Red level
is turned off in Square.dgn with the file tree collapsed. This causes the elements in the
files collapsed under Square.dgn to be turned off also.

Level Display X Level Display X
FEEEERE vewbispe ~| FEFERF) vewbissy ~
\@ IE §]>° [none] = M — R@ IE:TE E}O [home] *  Levels ¥

= @ Blank.dgn = m Blank.dgn
+ m Square.dgn + m Square.dgn

M ame Mame
DRAFT_CO-Red [ DRAFT_CO-Red

[ efault

‘ | ‘. |

In this illustration, the file tree has been expanded so that when the DRAFT_CO-Red
level in Square.dgn is turned off the other files are unaffected and only the square

disappears.
Level Display X Level Display =
FEEFEFRE vew il <] EEEECER Mesbse =]
\@ IIEETE E}n [hone] = M e \@ E E}O [home) v Levels ¥

D = Elank.dan = Blank.dgn
= E Square.dgn = @ Square.dan
= @ Circle.dgn = m Circle.dgn
O E Triangle.dgn O @ Triangle.dgn

Name Mame

DRAFT_CO-Red :DBAFT_CO-Red

[ efault

< N

Levels that are used in nested attachments which are not used in the main attachment will
be displayed in the Level Display dialog box. The name of the first attachment
containing the level is displayed.
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Level Display

Wiew Dizplap

M

\@ ITE.TE E}“ [none] = Levels ¥

5 Elank.dgn
+ @ Square.dgn

DRAFT_CO-Red
DRAFT_CO-Green

Drefault

|

Square.dgn
Green_Trangle.dgn
Square.dgn

| i

With the tree view collapsed, turning on or off a level in a collapsed file will affect all
collapsed files using that level.

Two more files have been added to the example, Green_Triangle.dgn and
Green_Square.dgn. Each of the new files use the DRAFT_CO-Green level. These are
attached to Square.dgn and are displayed by Live Nesting. With the file tree collapsed,
turning off the DRAFT_CO-Green level turns off the display in both files.

Level Display

\@ |.ETE E}“ (hone) v  Levels ¥

“igw Display hd

= m Blank.dan
+ m Square.dgn

51 /X

EYA

Name
DRAFT_CO-Red

O

DRAFT_CO-Green

Diefault

4

O

‘ | ‘ | ‘ | ‘ iew Digplay hd

NG [BE Brotmone)~ Lo v

=8 Blank dgn
+ /8 Square dgn

With the file tree expanded, the levels for the individual files can be manipulated without
affecting the same named levels in other attachments.
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Determining an Element’s File

Just by looking, there is no way to determine which file an element belongs to. However,
a Tentative snap on the element will display a tool tip listing the element’s Type, Level,
the Logical Name of the attachment, and its actual file name.

&
Tools  Settings

B BE &Y @ @ EEREE Ty

Slot_| File Mame todel Description Logical ]
1 Squaredgn COOT Default Global Origin aligne...
2 Cicle.dgn COOT Default Global Origin aligne...  Ref
3 Trangle.dan COOT Default Global Origin alione...  Ref-1 |
4 | 2

Scale [1.000000  : [1.000000  Rotation | 0°00" ¥ oo
[E[%&[ [ [E Gy ga[ﬁ 'tg:’? Copy Attachments ¥ | Depth: ,T

Actual Name

[Shape [DRAFT_CO-Red], Ref Righ [Triangle.dan)|

Type Logical Name
Level

Logical Names and Slot Numbers for Reference Attachments
Logical Names

In MicroStation, a file can be used as an attachment within a single file numerous times.
Logical Names are used to distinguish one version of the attachment from another. A
logical name can be given to any attachment, but must be given to the second and
subsequent attachments of a file.

To give a logical name to an attachment, begin the attachment procedure as normal.
When the Reference Attachment Settings dialog box displays, key in the desired logical
name in the field provided. Finish the attachment process as normal.

Reference Attachment Settings for 12345DES_Model...

File Mame:  123450E5_Model. dan
Full Path: ...\Reference_Files\123450ES_Model.dgn
Model: [COOT Defalt Ea|

Logical Mame: | 100 scale detail

Descrption: | Global Origin aligned with Master File

Orientation:
Marne Diescription -
Caincident Aligned with M azter File
Coincident -*aorld  Global Origin aligned with k aster File
Top Standard View
Front Standard View
Right Standard Yiew j

Scale [Master:Ref] [1.000000 : |1.000000 W TrueScale

Nested Attachments: Mo Nesting b

v Display Raster References
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The logical name is displayed in the References dialog box as illustrated below:

EReferences (1 of 1 unique, 1 displayed)

/o

Tools  Settings

E=-| B

Hilite Mode:  Boundariez ™

Slat | File Mame todel D escription Logical
—

Presentation | [§]] o N|

(2 12M5DES Modeldon COOT Default

Global Origin aligne... §100 scale detail

1 ‘wireframe FEARE

| | |
12 Y P e ] . T

Slot Numbers

Slot numbers are assigned to attachments to provide another method of grouping the files.
They are used to assign the processing order when making shaded color or grayscale
prints. For more information on using slot numbers in this process, see:

CDOT Shaded Color And Grayscale Printing.pdf
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